BSBXBD404
ASSESSOR GUIDE — Part 2 of 2

Use big data for operational
decision making

Assessment 4 of b

Project

Version 1




Part E: Draft analytic report to identify insights into
operational decision #2

To complete this part of the assessment, you are required to:
o carefully read the scenario details and requirements outlined within this section
o referto and use relevant findings from the 80/20 rule analysis report created in Part D
e apply programming protocols and techniques when writing DAX statements as required in the tasks
o follow the procedure for integrating big data and analytics into operational workflow (Table 4: Checklist]
e continue to use the same Power Bl work file from Part D to do the tasks in this part of the assessment.

Scenario continued:

Previously you created an 80/20 rule [Pareto) analysis dashboard to identify the range of products (the top N]
that generates approximately 80% of revenue and also considered the effect of outliers.

Now, you are required to create a scenario analysis report to support ‘Operational decision #2'.

Operational decision #2: Based on the Top N% of products identified from the 80/20 rule analysis, the
management wants to decide on the optimum price adjustment % to apply to the selected products according
to the following operational decision-making (ODM] requirements.

o (ODM Requirement #1: The analysis should be based on the entire population of the 2021 sales data.

o (ODM Requirement #2: Display last year's [2021) total revenue as a key figure in the report so that this can be
compared against the target revenue scenario value projected for next year.

o (ODM Requirement #3: Apply identified insights on the “TopN %’ from the “Top N Products: 80/20 Rule
Analysis’.

o (ODM Requirement #4: The price adjustment percentage value should be adjustable between 0 to 30% in
0.5% increments, with a default value of 0%.

o (ODM Requirement #5: The price adjustment should only be applied to the Top N% of products
e (0ODM Requirement #6: The revenue scenario in the analysis must achieve the target value of $850,000.

You are also provided with the reporting requirements in ‘Table 3', which you must consider when customising
the dashboard template.

Table 3 - Reporting requirements

Report elements Specification details/notes

Report name: Revenue Scenario Analysis | Dashboard
Note: The format in the dashboard/report template must be maintained when customising.

Report sub-title: Goal: To analyse scenarios for price adjustment required to meet the sales target of $850K next
year.

Note: The format in the dashboard/report template must be maintained when customising.

Titles of visuals Set a meaningful titles for each visual as relevant for the analysis.
Procedure: Select, ‘General’ tab > ‘Title’ > Turn on and input title text accordingly.

Format: Titles should be formatted using the font type ‘Segoe U, font size “14’, font style: ‘Bold’
and text color ‘#094780".
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Report elements Specification details/notes

Required report The following filters are required to customise the visualisations in the report and to generate
filters: different outcomes based on selected criteria on the revenue scenario analysis.

e Slicer #1name: Select Year.
Specification: A slicer with the drop-down option to select past data from a specific year

e Slicer #2 name: TopN %
Specification: A slicer with a slider bar that allows to select single value adjustments.
Displayed as % values

e Slicer #3 name: Price Adjustment
Specification: A slicer with a slider bar that allows to select single value adjustments.
Displayed as % values

Filter format The following additional format settings are configured specifically for:
specifications:

o slicer visuals with dropdowns (e.g. for selecting specific items to filter the dataset]

o Visual > Slicer settings > Options > Style: Dropdowns
o Visual > Slicer header: Off
o Visual > Values > Font: Segoe Ul, size:14

o slicer visuals with slider bars for single value adjustments (e.g. for selecting numerical
values from a range]:
Visual > Slicer settings > Options > Style: Single Value
Visual > Slicer header: Off
Visual > Values >Font: Segoe Ul, size:14, style: Bold, Font Colour: #FFFFFF
Visual > Slider: On
General > Title: On
= Text: <type here the name of the variable used to affect the analysis>
= Font: Segoe Ul, size:14, style: Bold Font size: 14
= Text colour: #FFFFFF
o General > Effects > Background: On
= (Color: #094780
= Transparency: 0%
Placement of All ‘Slicer’ visuals must be placed on the ‘Filters’ section of the dashboard template.
report elements:

O O O O O

All ‘Card’ visuals that display key figures must be placed within the ‘Key Figures’ section of the
dashboard template.

All other visuals that display further breakdowns of the key measures must be placed within the
‘Breakdown’ section of the dashboard template.

Draft a what-if scenario analysis report in Power Bl Desktop by applying identified insights to support
‘Operational decision 2#' requirements outlined in the scenario and ‘Table 3 - Reporting requirements’.

When doing this task, you must:

1. plan, organise and efficiently follow the logical sequence of the procedures outlined in ‘Table 4’ checklist.

2. use mathematical concepts and statistics required to complete, at times, complex calculations required for
the report according to the specifications provided in the checklist.

3. record relevant numerical data using the appropriate visuals in Power Bl Desktop and ensure that the report
includes the following elements:
a. the correct report title and sub-title
b. the required filters to select

e the correct dataset based on the required year
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e the price adjustment percentage value
c. appropriate visualisations to display

e key figures of the analysis

e Dbreakdowns of the revenue data.

Assessor instructions: The students must complete all tasks in the ‘Table 1" checklist. Additional instructions
are included within certain tasks in the checklist to provide specific configuration guidelines for the assessor [in
red text]. However, evidence of completing all the tasks correctly will be visible from the completed Power Bl
dashboard screenshot provided by the Student. When marking the screenshot please refer to the additional
assessor instructions provided under the section ‘Screenshot evidence:’

Table 4 - Procedures for operational decision #2

# Sub-task details Tick/check

once
completed.

Do the following tasks using the ‘Report’ view in the Power Bl work file.

1. | Duplicate the ‘Dashboard Template’ to create a new page for the analysis. Rename the page as ]
‘Revenue Scenario Analysis (Draft]’.

2. | Customise the title and sub-title of the dashboard according to ‘Table 3 - Reporting ]
requirements’.

3. | Fulfil ‘'ODM Requirement #1' by adding a ‘Slicer’ visual on the dashboard page so that the correct ]
sales data is set as the basis for operational decision-making.

Customise the visual format settings according to ‘Table 3 - Reporting requirements’

Assessor instructions: The ‘Year’ field should be selected for the ‘Slicer’ visual. The year 2021
should be selected from this visual.

4. | Fulfil ‘ODM Requirement #2' by copying and pasting the card visual ‘Total Revenue’ from the ‘Top ]
N Product: 80/20 Rule Analysis’ page to the ‘Revenue Scenario Analysis [draft])’ page.

When doing this task, you must:
e change the ‘Title' of this visual to ‘Revenue Last Year'.

e position the visual in the appropriate section for displaying key figures in the report.

5. | Fulfil ‘ODM Requirement #3' by copying and pasting the following visuals from the ‘Top N ]
Product: 80/20 Rule Analysis’ page to the ‘Revenue Scenario Analysis [draft]’ page.

e The ‘TopN %’ parameter ‘Slicer’ visual.

Note: Choose to ‘Sync’ the new slicer with the settings in the ‘80/20 Rule Analysis’
report, so the same ‘TopN %’ value will apply to the scenario analysis report.

e The ‘Top N Products’ ‘Card’ visual [which displays the value from the ‘No. of Selected
Products from TopN%' calculated measure).

When doing this task, you must:

e position the ‘TopN Products’ card visual in the appropriate section for displaying key
figures in the report

e position the ‘TopN %’ slicer visual in the appropriate section for displaying filters in the
report.
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# Sub-task details Tick/check

once
completed.

Fulfil ‘ODM Requirement #4' by creating a field parameter called ‘Price Adjustment’ as a numeric ]
range according to the specifications outlined in the scenario.

Note: When doing this task, you must also ensure that
e a ‘Slicer’ visual is added to the report page

e the ‘Price Adjustment’ field is correctly formatted as a ‘Percentage’ with 1 decimal point.
The correct format should be visible in the ‘Slicer’ visual added to the report page.

e the slicer visual is positioned in the appropriate section for displaying filters in the
report.

e thisslicer visual is formatted according to the ‘Filter format specifications’ as outlined in
‘Table 3: Reporting requirements’.

Assessor instructions: The procedure and specifications to do this task are as follows.
Procedure: From Power Bl Desktop, navigate to the ‘Modelling’ tab > ‘New parameter’ > Select
‘Numeric range’ and customise according to the following specifications.

Specifications:

e Name of the parameter: Price Adjustment
e Datatype: Percentage

e Min:0

e Max:0.301

e Increment: 0.005
e Default: 0

e Select option to ‘Add slicer to the page’.

7. | Create a new table called ‘Scenario Measures’. ]
8. | Create a DAX formula called ‘Pricing Scenario’ within the ‘Scenario Measures' table. ]
Note: The DAX formula for the ‘Pricing Scenario’ must:
e calculate the sum of sales using the ‘Unit Price’ and ‘Quantity’ fields from the
‘Transactions’ table
e incorporate the [Price Adjustment Value] parameter to adjust the unit price according to
the ‘Price Adjustment’ percentage selected in the report
e apply the following basic mathematical formula within the ‘SUMX’ function following the
correct protocols and techniques for writing the DAX statement in Power BI.
= (Unit Price * (1 + [Price Adjustment Value])) x Quantity
Assessor instructions: The correct DAX statement is provided below.
Pricing Scenario = SUMX(
Transactions,
(Transactions[Unit Price] * (1+[Price Adjustment Value]) )
* Transactions[Quantity]
)
9. | Create the following three [3) measures within the ‘Scenario Measures’ table, required to fulfil ]
‘ODM Requirement #5'.
Note: Use the DAX statements provided and apply correct programming protocols and
techniques when typing in the DAX statements into Power Bl's formula bar.
Measure 1
Revenue Scenario (TopN) =
VAR ProdNum = [No. of Selected Products from TopN%]
RETURN
CALCULATE([Pricing Scenario],
FILTER(VALUES('Product'[Product ID]),
RANKX(VALUES( 'Product'[Product ID] ), [Total Sales], , DESC ) <= ProdNum))
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Sub-task details Tick/check
once

completed.

Note: Format this measure to display in a currency format with two decimal points..
Measure 2
Revenue Scenario (Other) =
VAR ProdNum = [No. of Selected Products from TopN%]
RETURN
CALCULATE([Total Sales],
FILTER(VALUES('Product'[Product ID]),
RANKX(VALUES( 'Product' [Product ID] ), [Total Sales], , DESC ) > ProdNum ))
Note: Format this measure to display in a currency format with two decimal points.
Measure 3
Revenue Scenario (Target) = [Revenue Scenario (TopN)] + [Revenue Scenario (Other)]
Note: Format this measure to display in a currency format with two decimal points.
10.| Use ‘Card’ visuals to display the previously created calculated measures and format according to ]
the specifications given.
Key Measures Name to display on visual | Visual formatting
Revenue Scenario Scenario Revenue (Other] e Visual >Category label: Off
(Other] .
e General > Title: On
Revenue Scenario Pricing Scenario Revenue o Title text: Displayas
specified in ‘Name to display
(Top N] (Top NJ o
on visual’column.
Revenue Scenario Target Scenario Revenue o Font: Segoe Ul, Size: 22
(Target] (Top N + Other] General > Effects > Background
colour: #CCCCCC
11.| Add a ‘Waterfall chart’ to display ‘Revenue Scenario (Target]’ vs. ‘Product Sales Cumulative ]
Percentage’ by ‘Month'.
Note: You must:
e Position the visual in the appropriate section for displaying breakdowns in the report.
o Title the visual as ‘Revenue Scenario vs. Cumulative Percentage’
e Rename the field name used for this visual, as follows:
o ‘Revenue Scenario (Target]’, rename as ‘Revenue Scenario’
e Turnon ‘Data labels’.
12.| Add a ‘Clustered column chart’ to display ‘Total Sales’ vs ‘Revenue Scenario [Target]’ by ‘Month. ]
Note: You must:
e Position the visual in the appropriate section for displaying breakdowns in the report.
e Title the visual as ‘Revenue LY vs. Revenue Scenario’
e Rename the field names used for this visual, as follows:
o ‘Total Sales’, rename as ‘Revenue LY’
o ‘Revenue Scenario [Target]’, rename as ‘Revenue Scenario’
e Turnon ‘Data labels’.
13.| Add a ‘Clustered bar chart’ to display ‘Total Sales’ vs ‘Revenue Scenario [Target)’ by ‘Category ]
Name'.
Note: You must:
e Position the visual in the appropriate section for displaying breakdowns in the report.
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Sub-task details Tick/check
once

completed.

e Title the visual as ‘Revenue LY vs. Revenue Scenario by Product Category'.
e Rename the field names used for this visual, as follows:

o ‘Total Sales’, rename as ‘Revenue LY’

o ‘Revenue Scenario [Target]’, rename as ‘Revenue Scenario’

o ‘Category Name’, rename as ‘Product Category’

e Turnon ‘Data labels’.

14.| Add a ‘Table’ to Qisplay a summary of thg revenue figures from last year and product revenue ]
scenario according to the following specifications.
e Table Title: Summary of Revenue LY and Scenario
e Table columns:
o ‘Key Measures’[Product Rank]
= Note: Change the name of this field for this visual as ‘Ranking’
o ‘Product’[Product ID]
o ‘Key Measures’[Total Sales]
= Note: Change the name of this field for this visual as ‘Revenue LY’
o ‘Scenario Measures'[Revenue Scenario(Target]
= Note: Change the name of this field for this visual as ‘Revenue
Scenario’
e Table format: Set the visual > Style presents to ‘Condensed’.
15.

Fulfil ‘ODM Requirement #6' by adjusting the ‘Price Adjustment’ parameter to an appropriate ]
percentage value.

Important: You must take a screenshot of the completed analysis report with the filter settings
applied in the report as required for ‘Operational decision #2'. Include your screenshot under the
‘Screenshot evidence:’ section. Read the ‘Notes’ carefully to understand the details that must be
visible in the screenshot.

Screenshot evidence:

Assessor instructions: The screenshot provided may have different values due to different contexts/filters
selected by the Student. However, the following characteristics must be visible in the screenshot.

The dashboard should display values in the context of the year 2021.
The value selected for the ‘TopN %' must represent the same value selected as part of ‘Operational
decision #1' in the previous task [D4]. Note: The sample screenshot provided below displays the
numerical values in the context of when the “TopN%’ parameter is set to 25.6%.
The value selected for ‘Price Adjustment’ must allow the ‘Target Scenario Revenue [TopN + Other]’ card
visual to display a calculated revenue value that is more than $850K as evidence of meeting the
requirements for ‘Operational decision #2'.
The ‘Data’ pane, must show a total of six [6) new items created by the Student (see highlighted in the
sample screenshot]. This includes:

o Four (4] calculated measures under the ‘Scenario Measures’ table.

o Two [2) measures created under the ‘Price Adjustment’ table - these are created automatically

when the Student creates the ‘Price Adjustment’ parameter.

The key elements of the report/dashboard page must be visible along with any changes made to the
report template. These are circled in red and highlighted in yellow in the sample screenshot for ease of
identification.
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Notes: The screenshot provided for this task must clearly show the following details:
[Tick the checkboxes as you check your screenshot against each required item]

L ‘Report’ view of the Power Bl work file.
L] Full view of the ‘Revenue Scenario Analysis (draft]’ page showing key elements of the report such as:
e [lthe relevant report title, and sub-title
e [lrequired filters to select the correct ‘Year’, ‘TopN %’ and ‘Price Adjustment’
o [lthe key figures required for the analysis such as, ‘Revenue Last Year’, ‘TopN Products’,
‘Scenario Revenue(Other]’, ‘Pricing Scenario Revenue [TopN]', ‘Target Scenario Revenue
(TopN + Other)’
o [la‘Waterfall chart’ displaying ‘Revenue Scenario’ vs. ‘Cumulative Percentage’.
e [la‘Clustered column chart’ displaying ‘Revenue LY’ vs ‘Revenue Scenario’ by ‘Month.
o [la‘Clustered bar chart’ to display ‘Revenue LY’ vs ‘Revenue Scenario’ by ‘Product
Category’.
e [lasummary table of revenue figures including the necessary columns ‘Product Rank’,
‘Product ID’, ‘Total Sales’ and ‘Revenue Scenario (Target].

[ ‘Data’ pane showing the new statistical measures, calculated columns and field parameters (6 items
in total) created for this analysis. They are:

o [JPrice Adjustment

o [Price Adjustment Value
o [Pricing Scenario
(]
O

[LJRevenue Scenario [Other]
[IRevenue Scenario [TopN]
o [Revenue Scenario (Target)
L] Title bar showing the file name with your name initials and current date.

BSBXBDA404_04 Data Analysis Report_StudentName_16U32025 - bower i Deskiop

File Home Insert Modeling View Help External tools Format Data / Drill
= A =
EGhDhbEe b PR 4Edg E 8 ah
Get Excel Data L Enter Dataverse Recent Tran: resh New Text e Publish
atpainter | datav workbook hubv er data  sourcesv dat visual s v
I & « Data »
REVENUE SCENARIO ANALYSIS AUs €=
| DASHBOARD ) 4 5
. Retail i3
= g
o I~ . -
&8 GOAL: TO ANALYSE SCENARIOS FOR PRICE ADJUSTMENT REQUIRED TO MEET THE SALES TARGET OF $850K NEXT YEAR. d | B | B KeyMeasures
S > Categoy
. .. . - 2 °
Select Year 4 Revenue Last Year Top N Products Scenario Revenue Pricing Scenario Target Scenario Revenue ® > Eoate
2091 2021 = - (Other) Revenue (Top N) (Top N + Other) B Price Adjustment
O = [ [ Price Adjustment
[y $731.23K 388 ¢11780K $733.04K  $850.84K ) B mesgarenrie
> BB Product
Revenue Scenario vs. Cumulative Percentage Revenue LY vs. Revenue Scenario by v Scenario Measures
®incresse @Decresse @70l Product Category
S10M L Seanario
B . [ B Revenue Scenario (Target)
oy e : = 0 8 Revenue Scenario (Toah)

> B Statistics

g > BEl TopN%:.
E c > B8 Transactions
g Rfvenu: LYrvs. Rervenue Scenario
E ®Revenue LY @Revenue Scenario
8
]
) Proguct Demand Summary Dashboard Tooltip Dashboard Template Univariate Analysis Report Template Sales: Univariate Analysis Report Top N Product: 80/20 Rule Analysis Revenue Scenario Analysis (Draft) n
Page 8 0f 8 —
Figure 6 - Screenshot of the ‘Revenue Scenario Analysis [Draft])’ page created using Power Bl Desktop © Microsoft
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Note: Once you have recorded the screenshot evidence, save and close your Power Bl work file as you will
continue to work on this file again for the tasks in Part G.

Part F: Seek input from Stakeholders
To complete this part of the assessment, you are required to:

o carefully read the scenario details outlined within this section
o follow organisational policies and procedures provided

e use a screenshot of the previously created Power Bl scenario analysis report from Part E to obtain
feedback.

Scenario continued:

You have created a draft of the revenue scenario analysis report based on the sales transactions data for 2021
[assuming that this is the last calendar year] to support the following two (2] operational decisions for AUS
Retail’s Sales and Production departments.

Operational decision #1: To decide on the number of products (from the top N %] that should be selected for
pricing adjustments for next year.

Operational decision #2: To decide on the optimum price adjustment % that should be applied to the selected
products, to meet the revenue target of $850K for next year.

You have been informed that the key stakeholders (Karen Jones and Daniel Brown) who requested the revenue
scenario analysis report are unavailable for meetings this week. Therefore, you have decided to contact them
directly via email to obtain their input and feedback on the draft version of the scenario analysis report.

You plan to include a screenshot of the scenario analysis report page in the email and a copy of AUS Retail’s
recommended Draft report design feedback form to help identify any amendments that must be integrated into
the report before finalising it.

You are aware of the following AUS Retail’s policy documents that include important procedures and templates
that must be used in the process.

- ‘AUS Retail_Stakeholder communication policy.pdf’ > section 5.2 - outlines AUS Retail’'s recommended email
communication protocols

- ‘AUS Retail_Data analysis and reporting policy.pdf ‘> section 8.1 - outlines the procedure for obtaining draft
report feedback and includes the template of the draft report feedback form.

Write a draft email addressed to the required stakeholder/s, requesting them to provide feedback on the
scenario analysis report, developed using Power Bl Desktop.

When drafting the email, you must:

1. briefly outline the following using clear, specific and industry-related terminology:
o the purpose of the email
o the outcome of the big data analysis in the report and parameters applied to support
‘Operational decision #1' and ‘Operational decision #2'.
2. include a clear screenshot of the scenario analysis report page to present the insights in Power BI
Desktop format, using the recommended ‘Draft report feedback form’ in the body of the email

Note: The screenshot must display the two (2] optimum decisions related to the price and demand
adjustments required to meet the sales target.

3. request a response from the recipient, with feedback on the draft report according to AUS Retail’s
policies and procedures.
4. use AUS Retail's standard email template to draft the email.
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(Word count: 85 - 120 words in the email body, excluding any text in the Draft report feedback form).

Portfolio of evidence: [Drafted email to key stakeholder and form completion)

Draft your email in the space given below.

Assessor instructions: Student responses are likely to include different wording than the sample answer
provided. However, the acceptable responses must:

e Dbe within the specified word limit [for the email body]
o reflect the characteristics described in the exemplar answer

e include a copy of the Draft report feedback form completed with a screenshot of the ‘Revenue
Scenario Analysis Report’ page.

A sample answer is provided below.

Lastname, Firstname

From: Lastname, Firstname

Sent: Tuesday, 14" February 2023 1:00 PM

To: Jones, Karen and Brown, Daniel

Subject: Revenue scenario analysis [draft]- Request for feedback

Hi Karen and Daniel,

I'm writing to request your feedback on the draft analysis developed according to your requirements for operational
decision-making. | have included a screenshot of what the report page looks like for your review. | would appreciate it if
you could please complete the Draft report design feedback form below with your feedback, comments and suggestions
and send it back to me at your earliest.

As a result of the scenario analysis based on last year’s [2021] data, a 19.5% price increase when applied to the 25.6% Top
N products [i.e. the top 388 items], together with the rest of the products (with no adjustments] results in generating
$850,843.94

Draft report feedback form
Screenshot:
Select Year [ Revenue Last Year Top N Products Scenario Revenue Pricing Scenario Target Scenario Revenue g
0 " 5, (Other) Revenue (Top N) (Top N + Other)
C $73123K 388 ¢11780K $733.04K  $850.84K
Revenue Scenario vs. Cumulative Percentage x;::: CL:: l:m/tnuu Scenario by
Iy -
" ot gl = —
B e
| I-IIIIIIIIII = EE
Figure 7 - Screenshot of the ‘Revenue Scenario Analysis Report [Draft]’ page created using Power Bl Desktop © Microsoft
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Feedback,
suggestions and
comments:

Looking forward to your response.
Thanks and kind regards,
Firstname Lastname

Operations Analyst
Firstname.Lastname@ausretail.com.au

Before printing this email please consider the environment. This message may contain privileged information or confidential information or both and is
intended for the recipient named. If you are not the intended addressee, please delete it and notify the sender.

Part G: Integrate feedback from Stakeholders and finalise
report
To complete this part of the assessment, you are required to:

o carefully read the scenario details outlined within this section

e use the Power Bl Desktop technology platform and the same Power Bl work file from Part E to integrate
the feedback.

Scenario continued:

Previously, you emailed a draft version of the revenue scenario analysis report to AUS Retail’'s key stakeholders
seeking their feedback and input.

In their response to your email, the stakeholders have requested a major functional change to be made to the
report, along with several minor design changes. The reason for the major functional change is due to them
realising that the price adjustments on the selected Top N products can potentially increase the demand for
other [non-selected) products.

According to the input received from the stakeholders, you have made the following detailed list of all the
changes that need to be integrated into the final version of the analysis report.

Feedback #1: Add a ‘Demand Adjustment’ parameter to the report in the numerical range between 0% - 20%,
with the ability to increment 0.1% at a time.

Feedback #2: Create a ‘Demand Scenario’ calculation that uses the input value from the ‘Demand Adjustment’
parameter that influences the quantity of the other [non-selected) products in the analysis.’

Feedback #3: Update the measure ‘Revenue Scenario (Other]’ to calculate the revenue for other [non-selected]
products based on the ‘Demand Scenario’ calculation.

Feedback #4: Configure the ‘Pricing Adjustment’ percentage value to increment by 0.1% at atime upto a
maximum value of 40%. This is because the stakeholders want to see the granular effect that smaller
percentage changes can make on the sales target value.

Feedback #5: Change the background colour of the ‘Target Scenario Revenue’ value to a different colour
(preferably a shade of yellow] to highlight and draw attention to at first glance.
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Feedback #6: Configure a different background colour (preferably an appropriate shade of green] for the ‘Price
Revenue Scenario (TopN]' key figure.

Feedback #7: Configure a different background colour (preferably an appropriate shade of blue] for the key
figure ‘Revenue Scenario (Other)'.

Feedback #8: Add the keyword ‘TopN’ to the title of the ‘Price Adjustment’ parameter as ‘Price Adjustment [Top
NJ’, so that it is clear this adjustment applies only to the TopN products.

Feedback #9: Add the keyword ‘Other’ to the title of the ‘Demand Adjustment’ parameter as ‘Demand
Adjustment [Other]’ and also to the key figure as ‘Demand Revenue Scenario [Other]’, so that it is clear this
adjustment applies only to the other [non-selected] products.

Feedback #10: Adjust the ‘Price Adjustment [Top N)’ and ‘Demand Adjustment [Other])’ parameters to their
optimum values that result in achieving the target revenue of $850K for next year.

Integrate the feedback received from the stakeholders by completing the sub-tasks in the following checklist.

Assessor instructions: The students must complete all tasks in the ‘Table 5’ checklist. Additional instructions
are included within certain tasks in the checklist to provide specific configuration guidelines for the assessor [in
red text]). However, evidence of completing all the tasks correctly will be visible from the completed Power Bl
dashboard screenshot provided by the Student. When marking the screenshot please refer to the additional
assessor instructions provided under the section ‘Screenshot evidence:'.

Table 5 - Checklist for integrating feedback into the scenario analysis

# Task details Tick/check
once completed.

Do the following in the ‘Report’ view of Power Bl Desktop.

1 Action ‘Feedback #1, by creating a field parameter called ‘Demand Adjustment’ as a ]
numeric range according to the specifications outlined in the scenario.

Note: When doing this task, you must also ensure that:
e a'Slicer' visual is added to the report page

o the ‘Demand Adjustment’ field is correctly as a ‘Percentage’ with 1 decimal point.
The correct format should be visible in the ‘Slicer’ visual added to the report page

e the correct visualisation format settings are applied in line with the standard
design of the report

o theslicer visualis positioned in the appropriate section for displaying filters in the
report.

o thisslicer visual is formatted consistently with other slicer visuals for displaying
parameter values.

Assessor instructions: The procedure and specifications to do this task are as follows.
Procedure: From Power Bl Desktop, navigate to the ‘Modelling’ tab > ‘New parameter’ >
Select ‘Numeric range’ and customise according to the following specifications.

Specifications:

e Name of the parameter: Demand Adjustment
e Data type: Percentage

e Min:0

e Max:0.201

e Increment: 0.001
e Default: 0

o Select option to ‘Add slicer to the page’.
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# Task details Tick/check
once completed.

2 | Action ‘Feedback #2' by creating a DAX formula called ‘Demand Scenario’ within the ]
‘Scenario Measures’ table.

Note: The DAX formula for the ‘Demand Scenario’ must:

e calculate the sum of sales using the ‘Unit Price’ and ‘Quantity’ fields from the
‘Transactions’ table (similar to the previously created ‘Pricing Scenario’ measure]

e incorporate the [Demand Adjustment Value] parameter to adjust the quantity
according to the ‘Demand Adjustment’ percentage selected in the report

e apply the following basic mathematical formula within the ‘SUMX’ function
following the correct protocols and techniques for writing DAX statement in Power
BI.

= Unit Price * (Quantity * (1 + [Demand Adjustment Value]))

Assessor instructions: The correct DAX statement is provided below.
Demand Scenario = SUMX(

Transactions,

Transactions[Unit Price]

* (Transactions[Quantity] * (1+[Demand Adjustment Value]) )

)
3 | Action ‘Feedback #3' by adjusting the DAX statement for the measure ‘Revenue Scenario ]
(Other)’ to calculate the revenue for other products based on the [Demand Scenario]
measure as follows.

Revenue Scenario (Other) =
VAR ProdNum = [No. of Selected Products from TopN%]
RETURN
CALCULATE([Demand Scenario],
FILTER(VALUES('Product'[Product ID]),
RANKX(VALUES('Product'[Product ID] ), [Total Sales], , DESC ) >
ProdNum ))

4 | Action ‘Feedback #4' by changing the increment and maximum values to the requested ]
value in the ‘Price Adjustment’ field.

Assessor instructions: The Student can change this by modifying the decimal value in the
DAX formula for ‘Price Adjustment’ as follows [see highlighted values].

Price Adjustment = GENERATESERIES(O, 0.401, 0.001)

5 | Action ‘Feedback #5’ by changing the background colour of the card visual for ‘Target ]
Scenario Revenue (TopN + Other)’ to ‘#E1C233’ with 50% transparency.

6 | Action ‘Feedback #6' by changing the background colour of the ‘Pricing Scenario Revenue ]
(TopN)’ card visual to ‘#3AAES9’ with 50% transparency.

7 | Action ‘Feedback #7' by changing the background colour of the ‘Pricing Scenario Revenue H
(Other]’ card visual to #5F92C0’, with 50% transparency.

8 | Action ‘Feedback #8' by renaming the title of the ‘Pricing Adjustment’ slicer to ‘Price ]
Adjustment (TopN].

9 | Action ‘Feedback #9' by: [
e renaming the title of the ‘Demand Adjustment’ slicer to ‘Demand Adjustment (Other].
e renaming the title of the card visual ‘Scenario Revenue [Other]’ to ‘Demand Scenario

Revenue [Other]’.

10 | Action ‘Feedback #10' by adjusting the two (2] required parameters to their optimum u
values to simulate achieving the sales target for next year.

11 | Once all feedback is actioned, rename the ‘Revenue Scenario Analysis (draft])’ tab in Power u
Bl to ‘Revenue Scenario Analysis [finalised)’
Important: You must take a screenshot of the finalised analysis report with the filter
settings applied in the report as required for operational decision-making requirements.
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# Task details Tick/check

once completed.

Include your screenshot under the ‘Screenshot evidence:’ section. Read the ‘Notes’
carefully to understand the details that must be visible in the screenshot.

Screenshot evidence:

Assessor instructions: The screenshot provided may have different values due to different contexts/filters
selected by the Student. However, the screenshot must indicate similar modifications to what is displayed in
the sample screenshot provided as evidence of integrating the feedback. The changes/modifications on the
report page are circled in red and highlighted in yellow for ease of identification.

Notes: The screenshot provided for this task must clearly show the following details:
(Tick the checkboxes as you check your screenshot against each required item]

L] ‘Report’ view of the Power Bl work file.
L1 Full view of the ‘Revenue Scenario Analysis [(finalised)’ page showing key elements of the report with
visible changes after integrating feedback.
[ ‘Data’ pane showing the new statistical measures, calculated columns and field parameters (3 items
in total) created as part of integrating feedback. They are:

o [IDemand Adjustment

o [IDemand Adjustment Value

o [JDemand Scenario
[ Title bar showing the file name with your name initials and current date.
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Figure 8 - Screenshot of the ‘Revenue Scenario Analysis Report’ page with feedback integrated using Power Bl Desktop © Microsoft
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Part H: Distribute recommendations of the finalised report

To complete this part of the assessment, you are required to:

o carefully read the task instructions
o referto the following sections of the ‘AUS Retail_Data analysis and reporting policy.pdf’ document for
guidelines and legislative requirements relevant to this task
o 8.1Guidelines for delivering insights using interactive dashboards/reports
o 9.2 Legislative requirements
o referto the ‘AUS Retail_Stakeholder communication policy.pdf’ > section 5.2for guidelines on
communication protocols.

Write a draft email addressed to AUS Retail’s key stakeholders for the purpose of distributing recommendations
of the finalised scenario analysis report.

When drafting the email, you must:

1. briefly outline the following using clear, specific and industry-related terminology according to the
‘AUS Retail_Data analysis and reporting policy.pdf’:
o the modifications made to the final version of the report
o the recommendations of the finalised scenario analysis report related to making
‘Operational decision #1' and ‘Operational decision #2’, with logical reasoning.
2. include a clear screenshot of the scenario analysis report page to present the insights in Power Bl
Desktop format within the body of the email

Note: The screenshot must display the two [2) optimum decisions related to the price and demand
adjustments required to meet the sales target.

3. use AUS Retail's standard email template to draft the email.

(Word count: 100 - 150 words in the email body]

Portfolio of evidence: (Drafted email to key stakeholders]

Draft your email in the space given below.

Assessor instructions: Student responses are likely to include different wording than the sample answer
provided. However, the acceptable responses must:
e be within the specified word limit (for the email body]
o reflect the characteristics described in the exemplar answer when summarising the modifications
made to the report and recommendations from the analysis with logical reasoning
e include a screenshot of the completed ‘Revenue Scenario Analysis (finalised]’ page.

A sample answer is provided below.

Lastname, Firstname

From: Lasthame, Firstname

Sent: Tuesday, 08" March 2023 9:00 AM

To: Jones, Karen and Brown, Daniel

Subject: - Recommendations from the finalised revenue scenario analysis

Hi Karen and Daniel,

ASSESSOR GUIDE (BSBXBD404) Use big data for operational decision making SB\UPN
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Thanks for the feedback and input you've provided. The final version of the revenue scenario analysis report
now includes the additional demand adjustment parameter and other format changes you've requested. Please
see the attached screenshot of the final report that shows these changes.

My recommendations on the finalised revenue scenario analysis are as follows.

As a result of the scenario analysis based on last year’s (2021) data, to generate an $850K revenue target (at a
minimum] a 17.5% price increase must be applied to the 25.6% TopN products [i.e. the top 388 items], and a
9.7% demand adjustment must be applied to the rest of the products [non-selected). If the price adjustment,
demand adjustment and the TopN % of selected products is increased more than the specified percentage
values above, the target revenue can be increased accordingly.

BSBXBD404 04 _Data Analysis Report_StudentName_16032023 - Power Bl Desktop

File Home Insert Modeling View Help External tools

ELEBhE® O

Get Excel Data SQL Enter Dataverse Recent
datav workbook hubv Server data

mald 8 & a

Publish

P [

Transform Refresh New Text More New Quick
sourcesv datav visual  box visualsv measure measure

Clipboard Dstz Quaries nsare Calculstion

. Sensitivity Share
il —
REVENUE SCENARIO ANALYSIS | DASHBOARD AUS e
=2) Retail

QE GOAL: TO ANALYSE SCENARIOS FOR PRICE ADJUSTMENT REQUIRED TO MEET THE SALES TARGET OF $850K NEXT YEAR.

A
A
A

ERIEIEN
suoiezi|ensip
eleq

Select Year

Revenue Last Year

$731.23K

Top N Products

388

Demand Scenario
Revenue (Other)

Pricing Scenario
Revenue (Top N)

$129.23K  $720.77K

Target Scenario Revenue
(Top N + Other)

$850.00K

Key Figures

Revenue LY vs. Revenue Scenario by
Product C:
@Total Sales

Revenue Scenario vs. Cumulative Percentage

FILTERS

Revenue LY vs. Revenue Scenario

o3 @Reiene Scenaric
Demand Adjustment
(Other)

Breakdown

« it Demand Summary Dashboard Tooltip Dashboard Template Univariate Analysis Repart Template Sales: Univariate Analysis Report Top N Product: 80/20 Rule Analysis

Page 8 of 8

Figure 9 - Screenshot of the ‘Revenue Scenario Analysis Report’ page with feedback integrated using Power Bl Desktop © Microsoft

Thanks and kind regards,

Firstname Lastname
Operations Analyst
Firstname.Lastname@ausretail.com.au

Before printing this email please consider the environment.
This message may contain privileged information or confidential information or both and is intended for the recipient named. If you are
not the intended addressee, please delete it and notify the sender.
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Assessment checklist:

Students must have completed all activities within this assessment before submitting. This includes:

Part B: Access big data sources and summaries

B(1-3] |Table 1- Evidence of accessing big data summaries and sources. (Three screenshots provided] | |
Part C: Apply descriptive statistics and insight analysis

C(1-3] [Table 2 - Evidence of applying descriptive statistics and insight analysis. (Three screenshots 0

provided)
Part D: Use findings to identify insights into operational decision #1
D3 |A screenshot of the completed univariate analysis of sales data. | O

Part E: Draft analytic report to identify insights into operational decision #2

E[1-3] |A screenshot of the revenue scenario analysis [draft] | 0
Part F: Seek input from Stakeholders

F(1-4) |Email to stakeholders and form completion | O
Part G: Integrate feedback from stakeholders and finalise report

G(1-10) |A screenshot of the finalised report | n
Part H: Distribute recommendations of the finalised report

H (1-3] |Email to stakeholders including recommendations from the finalised report | |

Congratulations you have reached the end of Assessment [4]!

© UP Education Online Pty Ltd 2023

Except as permitted by the copyright law applicable to you, you may not reproduce or communicate any of
the content on this website, including files downloadable from this website, without the permission of the
copyright owner.
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